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1 Introduction 

 
1.1 Purpose 

 
The purpose of this document is to provide the developers with all the necessary tools and 

installation guides to setup and continue the development of Frog-B-Data, senior capstone 

project. This document contains a detailed breakdown of creating a cluster of nodes on Linux 

machines, Hadoop and Spark installation, and running sample codes on standalone as well as a 

cluster of nodes. Additionally, we provide detailed description on building the recommender on 

two separate frameworks.  

 

1.2 Overview 

 
This document includes the following four sections. 

 

Section 2 - Pre-Requisites: Gives a detailed description of the required operating system and 

pre-installed software on machines before beginning of the project. 

 

Section 3 - Hadoop: This section gives a very detailed description on the introduction to 

building Maven projects on Eclipse Mars, creating a cluster of network working on multiple 

nodes, installation of Hadoop on standalone and cluster of machines, deploying apps on single 

node and cluster, recommender and K-Means clustering using Mahout.     

 

Section 4 - Spark: This section gives a very detailed description on the introduction to building 

Maven projects on Eclipse Mars, creating a cluster of network working on multiple nodes, 

installation of Spark on standalone and cluster of machines, deploying apps on single node and 

cluster, Python development in Spark, recommender and K-Means clustering using MLlib. 

 

Section 5 - Glossary of Terms: Lists all the technical terms that are mentioned in this document 

with their definitions. 
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2 Pre-Requisites 

 
2.1 Ubuntu 15.04 
All machines involved in this project must be installed with Linux operating systems, preferably 

Ubuntu 15.04 which can be downloaded from the following link: 

 

http://releases.ubuntu.com/15.04/ubuntu-15.04-desktop-amd64.iso 

 

2.2 Java 8 download 
Java is the integral part of Frog-B-data project and all machines must have the latest versions of 

java installed using the following command line instructions: 

 

 
sudo apt-get update 

sudo add-apt-repository ppa:webupd8team/java 

sudo apt-get update 

sudo apt-get install oracle-java8-installer 

 
 

 

After entering these commands, verify that java is installed on your machine using the following 

command: 

 
java –version 

 
 

 

2.3 Eclipse Mars  
This project requires an IDE to develop the applications on Hadoop and Spark. Download the 

Eclipse Mars from the following link: 

 

https://www.eclipse.org/downloads/download.php?file=/oomph/epp/mars/R2/eclipse-inst-

linux64.tar.gz&mirror_id=1135 

 

Extract the downloaded file in your current directory, and go inside the newly created directory 

called ‘eclipse-installer’, and install eclipse by double clicking on ‘eclipse-inst’. In the next 

prompt window, choose the first option ‘Eclipse IDE for Java Developers.’ Choose your 

installation folder and click Install. 

 

 

 

 

http://releases.ubuntu.com/15.04/ubuntu-15.04-desktop-amd64.iso
https://www.eclipse.org/downloads/download.php?file=/oomph/epp/mars/R2/eclipse-inst-linux64.tar.gz&mirror_id=1135
https://www.eclipse.org/downloads/download.php?file=/oomph/epp/mars/R2/eclipse-inst-linux64.tar.gz&mirror_id=1135
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3 Hadoop 

 
3.1 Creating and managing Maven Projects in Eclipse Mars 

 
3.1.1 Open Eclipse Mars and create a new Maven project 

 Create a Maven Project: File->New->Project->Maven->Maven project 

 

 
 

 Use the default Maven Version and click next  
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 Enter the group Id and the artifact Id and the appropriate package name will be 

generated for you. 

Group ID:    identifies your project uniquely among all the projects. 

Artifact ID:  is the name of the jar without version. 

 

 
 

 POM file 

 POM stands for Project Object Model.  

 It is an XML representation of a Maven project held in a file named 

‘pom.xml’.  

 This file contains all the information about a project which includes all the 

plugins required to build the project and the dependencies of a project. Maven 

manages the list of all the programs and projects that a project depends on 

through the POM file.  

 By default, your POM file should look like this:  
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 Project Structure 

 Directories 

This is how a typical project directory looks as soon as you make a Maven 

project. As you keep adding dependencies in POM file, the list here would 

get bigger. 
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 Build Path 

Remove the default JRE System Library by right clicking on project, 

Select Build Path->Configure Build Path as shown in the following 

screenshot. Remove this library by pressing the remove button on the 

right. 

 
Now, go to Add Library then select JRE System Library from the window 

prompt, press ‘Next’ and then press ‘Finish’. You should see something similar as 

depicted in the following screenshot: 
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3.2 Writing Word Count and Matrix Multiplication programs 

 
3.2.1 Word Count-my first MapReduce program 

 Word Count-Hello World of Hadoop 

 Now you are all set to write your first MapReduce program, Word Count. 

 Word Count is called the ‘Hello World’ program of the Big Data 

development. 

 It is exactly what you think. We will have a text file as the input and we write 

MapReduce code to count the number of words in that input file. 
 Setup the WC project 

 Create a new Maven project named WordCount 

 Edit the pom.xml file for Maven dependencies 

 Hadoop-client 

http://mvnrepository.com/artifact/org.apache.hadoop/hadoop-

client/2.7.1 

 Edit the POM file to include the required dependencies. Add the Apache 

Mahout and Apache Hadoop dependency in pom.xml. Here is a screenshot of 

what your POM file should look like:  

 

 

 

 Fix the build path 

 Now fix the build path as mentioned earlier in the manual. 

 Word Count Algorithm 

 The Map phase in our word count code filters the input data and gives the 

value of 1 to each word of the text file. 

http://mvnrepository.com/artifact/org.apache.hadoop/hadoop-client/2.7.1
http://mvnrepository.com/artifact/org.apache.hadoop/hadoop-client/2.7.1
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 The Reduce phase then takes the input from the map phase (filtered data) and 

then counts the number of time each word occurs (sorting by key). 

 Format of input file 

 The input file can be normal text file with words in it. These words can be in 

any language and in any format. 

 Format of output file 

 The output file will have each word and its count in each line and will be 

sorted alphabetically. 

 Congratulations on running your first MapReduce Program 

 

3.2.2 Matrix Multiplication 
 Matrix Multiplication 

 Next we build matrix multiplication MapReduce Program to multiply two 

matrices. 
 Setup the MM project 

 Create a new Maven project named MatrixMultiply 

 Edit the pom.xml file for Maven dependencies 

 The POM file will be the same as we had for word count as we need 

Apache Mahout and Apache Hadoop as the dependencies. 

 

 Fix the build path 

 Fix the build path as we mentioned earlier in the manual. 
 Format of input files 

 We will have 2 input files. Both the files will have one matrix each. Each line 

of the input files will have the name of the matrix, row, column, value.  
For example:  

  
Matrix A  Matrix B  

(2*5)   (5*3) 

 Matrix Multiply Algorithm 
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 There are two Map functions, one for each matrix. They filter and sort the data 

according to key and send this sorted data to the reduce phase. 

 The reduce function performs the summary operation of multiplying the 

appropriate values. 

 Format of output file 

 The output will have the final matrix in the form of: row, column, value 

Your output file should look something like this:  

 
Result Matrix 

(2*3) 

 Congratulations on running your second MapReduce Program 
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3.3 Install Hadoop on Single Node 

 
3.3.1 Installation instructions 

 The following commands will help you set up a dedicated Hadoop user. In this 

manual, we have used a user called ‘hduser’, but you can use any other username. 

Also you would have to get root access for the dedicated user by modifying the 

sudoers file. 
 

sudo addgroup hadoop  

sudo adduser --ingroup hadoop hduser 

sudo vim /etc/sudoers 
 

 
 Hadoop requires SSH access to manage its nodes i.e. the remote machines in the 

cluster and the local machine. The following commands would help you install SSH 

and configure it to allow SSH public key authentication so that you would not have to 

enter the password each time you try to access a remote machine. 

 If asked for a filename, just leave it blank and press enter to continue.   

 Also, you have to disable IPV6 as the Hadoop version we used does not 

support it. This will be done by modifying the sysctl.conf file. 

 
sudo apt-get install openssh-server 

ssh -keygen - t rsa -P “” 

cat $HOME/.ssh/id_rsa.pub >> $HOME/.ssh/authorized_keys 

sudo vim /etc/sysctl.conf  
 

 Update the file with the following lines: 

 
 Once you are done with these commands, reboot the machine with the 

following command. 

 
sudo reboot 

 
 Download Hadoop 2.7.1* from the following link: 
http://supergsego.com/apache/hadoop/common/hadoop-2.7.1/hadoop-2.7.1.tar.gz 

*Note - During the period of our project, we worked with Hadoop 2.7.1, 

but we are sure that while reading this manual there will updated versions 

available. If you want you can go ahead and download the most recent version, 

but remember to change some commands wherever required. 

http://supergsego.com/apache/hadoop/common/hadoop-2.7.1/hadoop-2.7.1.tar.gz
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 The following commands will help you extract the zipped Hadoop folder and 

move the Hadoop folder to Hadoop folder as per your convenience.  

 

 Then you will have to assign ownership of that folder to the user you chose 

using the chown command. 

 

 Further, we create the namenode and datanode folders in the Hadoop-

tmp folder and assign the ownership of this temp folder to the user you 

chose using the chown command again.  

 
tar xvcf hadoop-2.7.1.tar.gz 

sudo mv hadoop-2.7.1 /usr/local/hadoop 

sudo chown hduser:hadoop -R /usr/local/hadoop 

sudo mkdir -p /usr/local/hadoop-tmp/hdfs/namenode 

sudo mkdir -p /usr/local/hadoop-tmp/hdfs/datanode 

sudo chown hduser:hadoop -R /usr/local/hadoop-tmp 

 
 

 Now we will modify the bash file to include the new variables. The following 

command will open the bash file.  

 
sudo vim ./bashrc 

 
 Append the bash file with the following variables: 

 

 
 
 Now we will be modifying some configuration files of Hadoop. Let’s open the 

directory which has all the Hadoop configuration files.  

 
cd /usr/local/Hadoop/etc/hadoop 

 
 We need to set JAVA_HOME by modifying the hadoop-env.sh file. 

This variable in the hadoop-env.sh helps Hadoop finds JAVA on the 

machine. 

 
vim /usr/local/hadoop/etc/hadoop/hadoop-env.sh 

 

 



Developer’s Manual v4.0 
 
 

12 
 

 Modify the core-site.xml file. This file contains the properties that override 

the default core properties. The only property that we change is the url of the 

default file system. 

 
vim /usr/local/hadoop/etc/hadoop/core-site.xml 

 

 
 

 Now we modify the hdfs-site.xml. We change the value of dfs.replication 

(default block replication) to 1 as we are running Hadoop on a single node 

right now. 

 We also change the value of dfs.name.dir and dfs.data.dir which 

specify where on the local filesystem the DFS namenode and DFS 

datanode blocks should be stored.   

 
vim /usr/local/hadoop/etc/hadoop/hdfs-site.xml 
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 Now modify the yarn-site.xml. In this we set up yarn to work with 

MapReduce Jobs. 

 
vim /usr/local/hadoop/etc/hadoop/yarn-site.xml 

 

 
 
 Modify the mapred-site.xml. We only change the value of the MapReduce 

framework to yarn as we yarn as our runtime framework for executing 

MapReduce jobs.  

 
vim /usr/local/hadoop/etc/hadoop/mapred-site.xml 

 

 
 

sudo reboot 

start-dfs.sh 

start-yarn.sh 
 

 Note – If you were guided here from Spark single node (with HDFS) installation 

Click here to continue. 
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3.4 Deploy WC and MM on single Node Hadoop 

 
3.4.1 Export JAR file with all dependencies 

 Right-click on the project -> Run As -> Maven Build 

 On the pop-up window, write ‘clean install’ in the Goals text box and click 

run. Here is a screenshot of what it should it look like. 

 
 You should see the progress of Maven building the project on the console. 
 You can find the newly created jar file of the project inside the ‘target’ folder of the 

project.  
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Note: All these 4 steps have to be followed in case of both: word count and 

matrix multiplication.  

 

3.4.2 Put the input file on HDFS 
 Now we have to put our input file(s) on the HDFS before running the job on the 

Single –Node Hadoop. 

 Before putting the file on the HDFS, we need to create a directory on HDFS. 

The following command will help you do that. 
hadoop fs –mkdir –p directory_path 

 

 
The command to put any file on HDFS is:  

 

 
hadoop fs -put path_to_local_file path_on_hdfs  

 

In the case of word count, you will have to put only one input file as it requires 

only one input file, but in the case of matrix multiplication you will need to put 

both the files as mentioned earlier in the manual. 

3.4.3 Run the job through terminal 
 Running the job from the terminal is easy. The following is the generalized command 

to do that. 
 

hadoop jar path_of_jar package_name.classname args  
  

 

 
3.4.4 Access the output from HDFS and interpret results 

 Accessing the output from HDFS requires you to open the Hadoop Web interface. 
Click on Utilities -> Browse the filesystem. 

Find your output directory and you have the option of downloading the output file 

or opening it.   

 

3.5 Setup a YARN Cluster 

 
3.5.1 Why cluster? 

 Hadoop was never built to run on a single node. There is no point of doing that except 

when you are testing your MapReduce code. 
 Hadoop becomes powerful and runs at its best in a cluster of nodes. 
 Parallel processing is only possible in a cluster where the data can be distributed 

among different nodes (datanodes) which are controlled by a manager node 

(namenode). 
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3.5.2 Structure of our cluster 
 Our Cluster had 3 nodes, each with a configuration as follows: 

 8 GB RAM 

 500 GB HDD 

 Ubuntu 15.04 
 Manager-Worker Architecture 

 1 Manager 

 2 Workers 
3.5.3 Install Hadoop on 2 separate machines (workers) Using 3.3 

 Change the appropriate configuration files 
 

sudo vim /etc/hosts 
 

 This is just a sample. Use appropriate names and IP addresses based on your 

machines. The hosts file will have to be changed on all the nodes of the 

cluster. 

 
 

 Modify the masters file on all the nodes. This file tells hadoop which machine 

in the cluster is the manager.  

 
vim /usr/local/hadoop/etc/hadoop/masters 

 

 
 
 Modify the slaves file on all the nodes. This file lists all the worker nodes of 

the cluster. 

 
vim /usr/local/hadoop/etc/hadoop/slaves 

 

 
 
 We will have to modify the core-site.xml file to change the url of the default 

filesystem as it cannot be localhost now.  

 
vim /usr/local/hadoop/etc/hadoop/core-site.xml 
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 We modify the hdfs-site.xml file to change the value of dfs.replication as we 

will have 2 data nodes (2 workers) now.  

 
And also we assign the https address of the namenode which will provide us 

with the web interface of the HDFS filesystem. 

 

 We may or may not have specify the data.dir property depending on the node, 

if it is a data node we need to have that property or else not. If you want to 

have your manager node as a data node too, then you will need to specify this 

property in manager node too. 

 
vim /usr/local/hadoop/etc/hadoop/hdfs-site.xml 

 

 
 
 Modify the yarn-site.xml to give URL values to resource manager of yarn for 

easy access from the web.  

 
 

vim /usr/local/hadoop/etc/hadoop/yarn-site.xml 
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 Modify the mapred-site.xml file to give url values to the MapReduce job 

tracker and Job history web access.  

 
 

vim /usr/local/hadoop/etc/hadoop/mapred-site.xml 
 

 
 
 Once you are finished with all these modifications in the configuration files, 

rebbot your machine and start Hadoop! 

 

 
sudo reboot 

start-dfs.sh 

start-yarn.sh 
 

 

 Here is the overview of the Web interface of HadoopManager. The url would 

be hadoopmanager: 50070.  
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Click on data nodes to check your data nodes and their current state. 

 

 

 
 

Click here to continue YARN cluster installation for Spark. 
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3.6 Deploy WC and MM on Cluster 

 
3.6.1 Store the input files on HDFS 

 The command to upload a file on the HDFS in a cluster remains the same as in case 

of Single-Node Hadoop. 
 

hadoop fs -put path_to_local_file path_on_hdfs  
 

 Run the jobs through terminal 
The command to run a MapReduce Job on the cluster also remains the same as in 

case of Single-Node Hadoop. 

 
hadoop jar path_of_jar package_name.classname args  

 
 Access the output from the HDFS 

 

The method of accessing the output file(s) from the HDFS remains the same as in 

case of Single-Node Hadoop i.e. through the web interface. 

 

3.7 Recommender 

 
3.7.1 What is a recommender? 

 Now we come to the most interesting part of the project where we build our own 

recommendation system! 

 We are sure that you might have come across some mind of recommendation system 

in your lives. 

 The most popular ones are Netflix, Amazon, and Facebook etc. 

 If any of you who do not what a recommender is, it is a system which recommends 

you objects based on your history of ‘likes’ and ratings. 

 

3.7.2 Recommender types 

 There are two basic types of recommendation engine algorithms: 

 User-based: The items will be suggested to the user based on what other 

people with similar tastes seem to like. 

 Item-based: The items will be suggested to the user based on finding similar 

items to the ones the user already likes, again by looking to others’ apparent 

preferences. 

 

3.7.3 Co-occurrence algorithm 

 We used the co-occurrence algorithm with the help of Apache Mahout to build the 

recommendation system in Hadoop. This type of algorithm is Item-based.  

 In this algorithm, we start by creating a co-occurrence matrix. It is not as hard as it 

sounds! 

 We begin by finding some degree of similarity between any pair of items. Imagine 

computing a similarity for every pair of items and putting the results into a giant 

matrix. This is called a co-occurrence matrix. 
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 This matrix describes associations between items, and has nothing to do with the 

users. It computes the number of times each pair of items occur together in some 

user’s list of preferences. 

 For example, if there are 17 users who express liking for both items A and B, then A 

and B co-occur 17 times. 

 Co-occurrence is like similarity, the more two items turn up together, the more 

related/similar they are. 

 The next step is to compute a user vector for each user. This vector tells which movie 

has a specific user watched and which ones has he not. 

 The final step to get the recommendations is to multiply the co-occurrence matrix 

with the user vector.  

 

3.7.4 Implementing Co-occurrence recommender 

 We used the movie lens data for our recommender. Here is a link of the movie lens 

data: http://grouplens.org/datasets/movielens/ 

 The original format of the movie lens data is: 

userId movieId rating  timestamp 

 We convert* this format to the following format: 

userId,movieId 

 

*Note – The source code to convert from the movie lens format to our format 

can be found on the link: 

http://brazos.cs.tcu.edu/1516frogbdata/deliverables.html 

  

  We do this because our recommender in Hadoop is not rating-based, rather it is item-

based. It only takes into account the movies watched by the user.  

 In the next step, you would have to upload the input file with the users and the movies 

they have watched on the HDFS using the hadoop ‘put’ command as mentioned 

earlier in the manual. 

 You can find the source code of our whole recommender on the link:  

http://brazos.cs.tcu.edu/1516frogbdata/deliverables.html 

  

 The command to run our recommender is as follows:  

 
hadoop jar path_of_jar_file frogbdata.tcu.recommendereg.RecommenderJobRun 

path_of_input_file_HDFS path_of_output_file_HDFS num_of_recommendations  
 

 There will be 6 jobs that will run in order to give the recommendations. Here is a 

screenshot of what it should look like: 

http://grouplens.org/datasets/movielens/
http://brazos.cs.tcu.edu/1516frogbdata/deliverables.html
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 Generating Users Vectors: generates a user vector for each user which shows 

what movies has a specific user watched. 

 Calculating co-occurrence: This job calculates the co-occurrences between 

every pair of movies. This job might take a while. 

 Item Index: This job has a quick map function to get the index of each item. 

 Partial Multiply: This job wraps the vectors and gets them ready for partial 

multiply. 

 Partial Product- Final: This is where we find the product of the matrices. This 

Job takes the longest time among all of them. 

 Final recommendation: this job sorts the recommendations and removes the 

movies that the user has already watched and gives the final 

recommendations. 

 The output file will be on the HDFS in the directory you mentioned in the command 

to run the job.  

 The output file will have the recommendations for each user and each user will have a 

value attached to it. 

Here is what it should look like: 
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3.8 K-Means Clustering 

 
3.8.1 What is clustering? 

 As the name suggests, Clustering implies grouping items together. But on the basis of 

what? 

 We use clustering in Big Data industry to group similar items/users together for better 

data management. 

 It has numerous applications in the business and helps them to target their customers 

in a better way. 

 K-Means algorithm is a simple, but widely used algorithm used for clustering. All 

objects need to be represented as a set of numerical features. Also, the user has to 

specify the number of groups (k) he wants. 

3.8.2 Application of clustering 

 Have you ever been creeped out of the advertisements on applications like Facebook, 

YouTube or any other website you visit? If yes, it is because of clustering. If not, then 

look carefully! 

 The advertisements have become personalized to a great extent. If you searching 

pattern on google shows that you read a lot about Big Data, notice how you are 

flooded with Big Data company advertisements and jobs. It happened with us! 

 There is no magic that goes behind this. The clustering algorithms help group similar 

kind of users together.  

 This is how a bank decides to give you a loan or not. Based on your social security, 

past credit and other financial details they put you in an appropriate group. 

3.8.3 Algorithm 

 The first step is to choose the number of clusters (k). For example, the user chooses to 

have 5 clusters. 

 In the next step, we choose 5 random records as the centroids of these 5 clusters.  

 Now we have 5 cluster centroids but they are randomly chosen. 

 Next, we assign each record/point to a specific cluster based on the distance of that 

point with the centroid of that cluster. 

 Next, we compute the distances from each point and allot points to the cluster where 

the distance from the centroid is minimum. 

 Once we are done with re-allotting the points to their new and final clusters, we create 

separate files for each cluster and save them into HDFS.  

3.8.4 Implementing K-Means clustering 

 The input files used for K-Means clustering were generated randomly from our code. 

The input file will be multi-dimensional and each line will have at least 15 records. 

Here is what our file looked like:  
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It is just a bunch of numbers! This is unstructured data and it might be a part of 

an excel file and now we will cluster each and every record. 

 In the next step you would put this file on the HDFS using the hadoop put command. 

 Again, you can find our source code for K-Means clustering on the following link:  

 

http://brazos.cs.tcu.edu/1516frogbdata/deliverables.html 

 Next, you would run the job using the following command 
hadoop jar path_of_jar_file apache.KMJob path_of_input_file_HDFS 

path_of_output_file_HDFS   
 

 Here is what your output should look like:  

 
 As you can observe in this file, it gives the cluster number (“CL-114”), its radius (r) 

and distance of each record from the cluster’s centroid. Also it lists each record that is 

a part of that cluster. 

 

 

 

 

 

 

http://brazos.cs.tcu.edu/1516frogbdata/deliverables.html
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4 Spark 

 
4.1 Creating and managing Maven Projects in Eclipse Mars 

 
4.1.1 Create a Maven Project: File->New->Project->Maven->Maven project 

 

 Use the default maven version and click next. 
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Enter the group Id (say tcu.frogbdata) and artifact id (name of the project, say 

wordcount) and the appropriate package name will be generated. 
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4.1.2 POM file 

 
 

4.1.3 Project Structure 

 Directories 

 This is a typical directory structure of a Maven project: 
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 Build Path 

 

Remove the default JRE System Library by right clicking on project, 

select Build Path->Configure Build Path as shown in the following 

screenshot. Remove this library by pressing the remove button on the 

right. 

 

 
 

Now, go to Add Library then select JRE System Library from the window 

prompt, press next and then press Finish. 

You should see something similar as depicted in the following screenshot: 
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4.2 Writing Word Count and Matrix Multiplication programs 

 
4.2.1 Word Count-my first Spark program 

 Word Count-Hello World of Spark 
 Setup the WC project 

 Create a new Maven project named WordCount 

 Edit the pom.xml file for Maven dependencies 

 Hadoop-client 
http://mvnrepository.com/artifact/org.apache.hadoop/hadoop-

client/2.7.1 

http://mvnrepository.com/artifact/org.apache.spark/spark-

core_2.10/1.5.2  

 Fix the build path 
 Word Count Algorithm 

 The Transformation phase in our word count code filters the input data and 

gives the value of 1 to each word of the text file. 

 The Action phase then takes the input from the map phase (filtered data) and 

then counts the number of time each word occurs (sorting by key). 

 All these two functions are performed in Spark main abstraction RDD 

(Resilient Distributed Datasets) 

 Format of input file 

 Refer to our User’s Manual and Research Result document. 

 Format of output file 

 The output file will have each word and its count in each line and will be 

sorted alphabetically. 

 Congratulations on writing your first Spark program 

 

4.2.2 Matrix Multiplication 
 Matrix Multiplication 

 Next we build matrix multiplication Java Spark Program to multiply two 

matrices. 
 Setup the MM project 

 Create a new Maven project named MatrixMultiply 

 Edit the pom.xml file for Maven dependencies 

 Hadoop-client 
http://mvnrepository.com/artifact/org.apache.hadoop/hadoop-

client/2.7.1 

http://mvnrepository.com/artifact/org.apache.spark/spark-

core_2.10/1.5.2  

 Fix the build path 

 Fix the build path as we mentioned earlier in the manual 

 

http://mvnrepository.com/artifact/org.apache.hadoop/hadoop-client/2.7.1
http://mvnrepository.com/artifact/org.apache.hadoop/hadoop-client/2.7.1
http://mvnrepository.com/artifact/org.apache.spark/spark-core_2.10/1.5.2
http://mvnrepository.com/artifact/org.apache.spark/spark-core_2.10/1.5.2
http://mvnrepository.com/artifact/org.apache.hadoop/hadoop-client/2.7.1
http://mvnrepository.com/artifact/org.apache.hadoop/hadoop-client/2.7.1
http://mvnrepository.com/artifact/org.apache.spark/spark-core_2.10/1.5.2
http://mvnrepository.com/artifact/org.apache.spark/spark-core_2.10/1.5.2
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 Matrix Multiply Algorithm 

 Get both matrices files and transform into a RDD 

 Convert both RDD into Matrix Entry type. 

 Convert both Matrix entries into coordinate matrix RDD and cache them since 

they are going to be used multiple time. 

 Now convert both coordinate matrices into Block matrix. 

 Then multiply both Block matrices and save the output file. 

 Format of input file 

 Refer to User’s and Research Results document. 

 Format of output file 

 The output will have the final matrix in the form of: row, column, value. 

 Congratulations on writing your second Spark program 

 

4.3 Install Spark on Single Node without HDFS 

 
4.3.1 Installation instructions in detail. 

 Download the latest version of scala or get the version used in the project from the 

following link: 

http://downloads.lightbend.com/scala/2.11.8/scala-2.11.8.tgz 

 

 Go to terminal, inside the Downloads directory and enter the following commads: 

 
$ tar xvf scala-2.11.8.tgz 

$ sudo mv scala-2.11.8 /usr/bin/scala 

$ cd 

$ vim .bashrc 

 

 Add the following lines at the bottom of your bashrc file: 

 
 Restart bashrc 

 
$ . .bashrc 

 
 

 Check the scala version to verify successful installation 
$ scala -version 

 
 

 

 

 

http://downloads.lightbend.com/scala/2.11.8/scala-2.11.8.tgz
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 Install git 
$ sudo apt-get install git 

$ git --version 

 
 

 

 Download Spark from the following link: 

http://d3kbcqa49mib13.cloudfront.net/spark-1.5.2-bin-hadoop2.6.tgz 

 

 Extract it in the home directory and rename the folder as ‘spark’ and enter the 

following commands: 

 
$ cd spark 

$ sbt/sbt assembly 

 
 

 Verify Spark installation by running a Pi example: 
$ ./bin/run-example SparkPi 10 

 
 

 

 You should get Pi’s value as 3.140… it means that Spark is successfully installed on 

your computer. 

 

4.4 Deploy WC and MM on single Node Spark without HDFS 

 
4.4.1 Export JAR file with all dependencies 

 Right-click on the project -> Run As -> Maven Build 

 On the pop-up window, write ‘clean install’ in the Goals text box and click 

run. Here is a screenshot of what it should it look like. 

 

http://d3kbcqa49mib13.cloudfront.net/spark-1.5.2-bin-hadoop2.6.tgz
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 You should see the progress of Maven building the project on the console. 

 You can find the newly created jar file of the project inside the ‘target’ folder of the 

project.  

 

 
 

Note: All these 4 steps have to be followed in case of both: word count and 

matrix multiplication.  

 Run the job through terminal 

 Run the following command: 
./spark/bin/spark-submit --master local path_to_jar package.class path_to_input path_to_output 

 
 Access the output from the desired location 

 

4.5 Install Spark on Single Node with HDFS 

 
4.5.1 Hadoop Installation 

If Hadoop is not installed on your machine, click here and follow the instructions of 

Hadoop installation on single node using this link: 

 
stop-dfs.sh 

stop-yarn.sh 

vim /home/username/spark/conf/spark-env.sh 
 

 
 
start-dfs.sh 

start-yarn.sh 
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4.6 Deploy WC and MM on single Node Spark with HDFS 

 
4.6.1 Export JAR file with all dependencies 

 Refer to the above instructions (4.4.1) 

4.6.2 Put the input file on HDFS 
 Refer to 3.4.2 for instructions 

4.6.3 Run the job through terminal 
 Run the following command: 

$ ./spark/bin/spark-submit --master yarn-cluster --num-executors 5 --executor-cores 1 --executor-

memory 3G path_to_jar package.class path_to_input path_to_output 
 

4.6.4 Access the output from HDFS and interpret results 
 Refer to 3.4.4 for instructions 

 

4.7 Setup a YARN Cluster 

 
4.7.1 Why cluster? 

 Hadoop was never built to run on a single node. There is no point of doing that except 

when you are testing your Spark code. 
 Spark becomes powerful and runs at its best in a cluster of nodes. 
 Parallel processing is only possible in a cluster where the data can be distributed 

among different nodes (datanodes) which are controlled by a manager node 

(namenode). 

 
4.7.2 Structure of our cluster 

 Our Cluster had 3 nodes, each with a configuration as follows: 

 8 GB RAM 

 500 GB HDD 

 Ubuntu 15.04 
 Manager-Worker Architecture 

 1 Manager 

 2 Workers 

 
4.7.3 Install Hadoop on 2 separate machines (workers) Using Hadoop instructions 

 Click here for instructions if you have not set-up a cluster. 
 Now change the appropriate configuration files  

stop-dfs.sh 

stop-yarn.sh 

vim /home/username/spark/conf/spark-env.sh 
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start-dfs.sh 

start-yarn.sh 
 

4.8 Deploy WC and MM on Cluster 

 
4.8.1 Store the input files on HDFS 

 Refer to 3.6.1 

 

4.9 Development in Python 

 
4.9.1 Install Python in all nodes 

 Python should come pre-installed in Ubuntu 15.04 and above. 

 
4.9.2 Install and configure PyDev plugin in Eclipse 

 Go to Help->Eclipse Marketplace 
 

Search “PyDev” in the Find textbox 

Select PyDev and install it with all default settings and restart eclipse. 

 

 
 

 Python Interpreters 
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In Eclipse, go to Window->Preferences 

In the left pane, select PyDev->Interpreters->Python Interpreter 

 

Click Quick Auto-Config to include the python path to the interpreter. 

 

 
 

Run the following commands in order to install NumPy (Numerical Python)  
sudo apt-get update 

sudo apt-get install python-numpy 

 
 

 In the Libraries tab, add the following folders: 

 /home/username/spark/python 

 /usr/lib/python2.7/dist-packages 

 /usr/local/bin 

 Add the following Zips 

 /home/username/spark/python/lib/py4j-0.8.2.1-src.zip 

 In the Environment tab, add the following Variables: 

 Variable Name: PROJECT_HOME, value: ${project_loc}  

 Variable Name: PYSPARK_SUBMIT_ARGS, value: --master local[*] –

queue PyDevSpark1.5.1 pyspark-shell 

 Variable Name: SPARK_CONF_DIR, value: /home/username/spark/conf 

 Variable Name: SPARK_HOME, value: /home/username/spark 

 Variable Name: SPARK_LOCAL_IP, value: IP address of the machine 
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Restart Eclipse for all the changes to take an effect. 

 Fix dependencies 

 Installation of pip 

 Download pip from the following link 

https://bootstrap.pypa.io/get-pip.py 

 Go into the downloaded directory and type the following command to 

install pip on your computer. 
sudo python get-pip.py 

 
 

 This will also install python setup tools and wheel if not already 

installed. Verify the installation of pip by entering the following 

command: 
whereis pip 

 
 

 If you get the following result, then the installation was successful. 

Pip: /usr/local/bin/pip /usr/local/bin/pip2.7 

 Installation of pydoop using pip 

 Enter the following command: 
sudo pip install pydoop 

 
 

 Verify the installation of pydoop by entering the following command: 
whereis pydoop  

 
 

 If the result is following, then the installation was not successful. 

Pydoop: 

 If this is the case, you will need to install pydoop manually. 

 Installation of pydoop manually 

 Download the tar file of pydoop from the following link: 

https://pypi.python.org/packages/75/75/085a6410b085f231328884ca3

349287a8705822ad8afdca715401e5c4f33/pydoop-

1.2.0.tar.gz#md5=e6b1dff3cf19cd7815b7134e67f683c4 

 

 

https://bootstrap.pypa.io/get-pip.py
https://pypi.python.org/packages/75/75/085a6410b085f231328884ca3349287a8705822ad8afdca715401e5c4f33/pydoop-1.2.0.tar.gz#md5=e6b1dff3cf19cd7815b7134e67f683c4
https://pypi.python.org/packages/75/75/085a6410b085f231328884ca3349287a8705822ad8afdca715401e5c4f33/pydoop-1.2.0.tar.gz#md5=e6b1dff3cf19cd7815b7134e67f683c4
https://pypi.python.org/packages/75/75/085a6410b085f231328884ca3349287a8705822ad8afdca715401e5c4f33/pydoop-1.2.0.tar.gz#md5=e6b1dff3cf19cd7815b7134e67f683c4
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 Extract the file and go inside the extracted directory. Now enter the 

following commands: 
vim pydoop/Hadoop_utils.py 

 
 Go to line 410 and replace this line 

self.__hadoop_home = None by 

self.__hadoop_home = ‘/usr/local/hadoop’ 

vim pydoop/utils/jvm.py 

 
 

 Go to line 27 and replace the line 
return os.environment[“JAVA_HOME”] by 

return ‘/usr/lib/jvm/java-8-oracle’ 

 
 

 Now enter the following command: 
sudo python setup.py install 

 
 

 Verify the installation of pydoop by entering the following command: 
whereis pydoop 

 
 

 You should get the following result:pydoop: 

 
pydoop: /usr/local/bin/pydoop 

 
 

4.10 Recommender 

 
4.10.1 Collaborative Filtering 

 In Spark, we used collaborative filtering algorithm using Apache MLlib library. 

According to Apache Spark documentation on MLlib collaborative filtering, 

“Collaborative filtering is commonly used for recommender systems. These 

techniques aim to fill in the missing entries of a user-item association 

matrix. spark.mllib currently supports model-based collaborative filtering, in which 

users and products are described by a small set of latent factors that can be used to 

predict missing entries. spark.mllib uses the alternating least squares 

(ALS) algorithm to learn these latent factors.” 

 To learn more about ALS algorithm, refer to this link. 

 

4.10.2 Source Code 

 To get the source code of our recommender, follow this link: 
http://brazos.cs.tcu.edu/1516frogbdata/deliverables.html 
Name of the file: MovieLensALSMain.py 
 
 
 
 
 

https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=10&sqi=2&ved=0ahUKEwizxp7OirrMAhUjuoMKHRkwDN0QFghCMAk&url=http%3A%2F%2Fwww.mf.uni-lj.si%2Fdokumenti%2Fcd96efab02612fe28baec3677c16b989.ppt&usg=AFQjCNHQf6dk5jihx6FhGuQ-0s4ORM3vUQ&sig2=GYET6uHBNg73pzi5ZfgFnA&bvm=bv.121070826,d.amc&cad=rja
http://brazos.cs.tcu.edu/1516frogbdata/deliverables.html
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4.10.3 Data Files for Spark Recommender 

 To get the data files, follow this link:http://grouplens.org/datasets/movielens/ 

 Here, you will find different sizes of the real movie ratings (100K, 1M, 10M, 20M 

and 22M).  
 For more details please refer to our User’s Manual and Research Results document. 

 
4.10.4 Instructions 

 To give the personalized ratings for any number of users, run the python script 

named “rateMovies” and follow the instructions: Keep in mind that the movies.dat 

file (movies.dat file should be the same file for which you want to run the 

recommender) should be in the same directory as the python script. This will 

generate the file called “personalRatings.txt” that contains the personal ratings of the 

user.  

 Sample run of the python script is as follows: 

 

 
 

 Note: To start the recommender on a cluster of 2 nodes, run the following 

commands: 

start-dfs.sh 

start-yarn.sh 

hadoop fs -mkdir -p /user/username1/spark_recommender/ 

hadoop fs -put /home/username/Downloads/ml-latest/ /user/username1/spark_recommender/ml-

latest/ 

hadoop fs -put /home/username/Desktop/personalRatings.txt/ 

/user/username1/spark_recommender/personalRatings.txt 

./spark/bin/spark-submit --master yarn-cluster --num-executors 5 --executor-cores 1 --executor-memory 

3G /home/username/workspace/MovieLensALS/src/MovieLensALSMain.py 

hdfs://HadoopSMaster:9000/user/username1/spark_recommender/ml-latest/ 

hdfs://HadoopSMaster:9000/user/username1/spark_recommender/personalRatings.txt 

hdfs://HadoopSMaster:9000/user/username1/spark_recommender/output22M 

 

 

 

http://grouplens.org/datasets/movielens/
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 Once the job is running, you can see the progress on the web with all the executors and the 

job process: 
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4.11 K-Means Clustering 

 
4.11.1 What is clustering? 

 As the name suggests, Clustering implies grouping items together. But on the basis of 

what? 

 We use clustering in Big Data industry to group similar items/users together for better 

data management. 

 It has numerous applications in the business and helps them to target their customers 

in a better way. 

 K-Means algorithm is a simple, but widely used algorithm used for clustering. All 

objects need to be represented as a set of numerical features. Also, the user has to 

specify the number of groups (k) he wants. 

 

4.11.2 Application of clustering 

 Have you ever been creeped out of the advertisements on applications like Facebook, 

YouTube or any other website you visit? If yes, it is because of clustering. If not, then 

look carefully! 

 The advertisements have become personalized to a great extent. If you searching 

pattern on google shows that you read a lot about Big Data, notice how you are 

flooded with Big Data company advertisements and jobs. It happened with us! 

 There is no magic that goes behind this. The clustering algorithms help group similar 

kind of users together.  

 This is how a bank decides to give you a loan or not. Based on your social security, 

past credit and other financial details they put you in an appropriate group. 

 

4.11.3 Algorithm 

 The first step is to choose the number of clusters (k). For example, the user chooses to 

have 5 clusters. 

 In the next step, we choose 5 random records as the centroids of these 5 clusters.  

 Now we have 5 cluster centroids but they are randomly chosen. 

 Next, we assign each record/point to a specific cluster based on the distance of that 

point with the centroid of that cluster. 

 Next, we compute the distances from each point and allot points to the cluster where 

the distance from the centroid is minimum. 

 Once we are done with re-allotting the points to their new and final clusters, we create 

separate files for each cluster and save them into HDFS. 
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5 Glossary of Terms 

Apache Hadoop: Apache Hadoop is an open-source software framework written in Java for 

distributed storage and distributed processing of very large data sets. 

Apache Hadoop Yarn: YARN (Yet Another Resource Negotiator) is a cluster management 

technology. It is characterized as a large-scale, distributed operating system for Big Data 

applications 

Apache Mahout: An Apache software used to produce free implementations of distributed 

scalable machine learning algorithms that help in clustering and classification of data. 

 

Apache Maven: A build automation tool for projects that uses XML to describe the project 

the project that is being built and its dependencies on other external modules. 

 

Apache Spark: Apache Spark is an open source cluster computing framework which allows 

user programs to load data into a cluster's memory and query it repeatedly. 

 

Big Data: Extremely large data sets that may be analyzed computationally to reveal 

patterns, trends, and associations, especially relating to human behavior and interactions. 

 

Collaborative Filtering: Method to predict the interests of a user based on interests of other 

users. 

 

Co-occurrence algorithm: Counting the number of times each pair of items occur together 

and then predicting the interests of a user based on the user’s previous interests and most co-

occurred items.  

 

HDFS: Hadoop Distributed File System is a Java based file system that provides scalable 

and reliable data storage. 

 

IDE: Integrated Development Environment. 

 

K-means clustering: A way of vector quantization used for cluster analysis in data mining. 

 

Map Reduce: A programming model and an associated implementation for processing and 

generating large data sets with a parallel, distributed algorithm on a cluster. 

 

MLlib: Apache Spark’s scalable machine learning library that consists of common learning 

algorithms and utilities including classification, clustering, filtering etc. 

 

PyDev: A Python IDE for Eclipse which is used in Python Development.  

 

Root Access: Access to install various software and related items on Linux machines. 

 

Scala: A programming language for general software applications. 
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XML: XML stands for Extensible Markup Language that defines the protocol for encoding 

documents in a format that is both, human and machine-readable. 

 


